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ABSTRACT

We need artificial lights in our daily lives. It makes it easier for us to work later in the day. Human
Centric Lighting helps our circadian rhythm by imitating the light cycle of the natural world. It
incorporates variations in Color Temperature and light intensity over the course of a day's 24-hour
cycle, taking into consideration the natural circadian rhythm of light and dark.

This study evaluated the relationship between task performance, as determined by Landolt's ring
experiment, and illumination in an indoor lighting setting using different level of Correlated Color
Temperature (CCT) comparisons. This establishes a system in which five subjects have been selected
one at a time, given the Landolt ring chart, and instructed to indicate the C-shaped rings' opening. The
subject's data have been collected using two different techniques. Throughout the session, the two
methods were had been used to record each participant's Galvanic Skin Resistance (GSR) and
Electroencephalography (EEG) data. This process has been followed at the end of each session in the
behavioural research.




OVERVIEW OF THE THESIS

Chapter 1: provides an overall overview of artificial lighting, an outline of the  experiment, and a

list of terms used in this thesis.

Chapter 2: offers a review of the study background and plenty of examples of reviews of the literature
on previous research on human performance in connection to biological and neurocognitive traits under

various indoor lighting settings. This chapter also covers how this research problem was formulated.
Chapter 3: delivers information about the idea of "Human Centric Lighting”.

Chapter 4: creates a work flow diagram to give a description of the complete experiment.

Chapter 5: Different Instruments used in this experiment.

Chapter 6: An Experimental design for identifying different biological parameters.

Chapter 7: Experimental results and analysis.

Chapter 8: Deals with the conclusion and the future scope of the thesis.
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1.1 INTRODUCTION

Up until the 1950s, buildings had been constructed to allow natural light to flow through practically
the whole interior. There are three main justifications for daylighting:

1. It improves indoor air quality and makes it healthier.
2. It saves money by reducing the consumption of energy.
3. It preserves natural resources and enhances the corporation's entire "green image."

The qualities of light in an interior setting differ greatly from those in an outdoor, natural one. However,
after dusk, they continue with their activities. Their well-being is therefore affected by the artificial
lights. It is essential to offer artificial illumination in an environmentally responsible and energy-
efficient manner. It is especially important to look for technical solutions that satisfy human
requirements while having the least negative effects on the environment while they are in use, when
most of the consequences occur. In addition to its enormous influence on the economy, the
environment, and industry—all of which have been significantly affected by indoor lighting since the
Industrial Revolution—its impact on people's quality of life and well-being has grown during the past
few decades.

The following 3 objectives have paralleled the evolution of the various interior lighting techniques:
enhanced photometric performance, increased energy efficiency, and optimized installation user
performance from an extensive viewpoint.

Building residents' psychological well-being can be influenced by lighting's visual comfort since, even
though humans see their luminous surroundings through their eyes, their brains process this
information. Modifications in brightness and color can accentuate beauty, elicit feelings, and change
our mood; the consequences of lighting are highly dependent on people and their mental states. The
"non-visual path" mediates how illumination affects the release or inhibition of these hormones; in
contrast, the "visual path” uses additional retinal cells called ipRGC to convert light into electrical
impulses, which are then used by rod and cone retinal cells to create an image in the visual cortex [101,
102]. whose output, rather than producing a visual impression, takes a different anatomical route to
ultimately induce the interior release or inhibition of certain chemicals.
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Up until 200 years ago, 90% of humanity's activities took place outside. People spend 90% of their
time indoors with artificial light because they live in a largely urbanized world that is biologically dark
(Begemann et al., 1997). The evolution of humanity has been in balance with the natural cycle of light
on Earth. The 24-hour human internal clock, commonly known as the circadian rhythm, is centered on
fluctuations in light levels and linked colour temperatures throughout the day (Bierbaumer, 2010). Lack
of regular exposure to dynamic lighting can cause circadian rhythm disruption, which can result in
health issues (Walerczyk, 2012). Human-centric lighting (HCL) is the term used to describe lighting
fundamentals that prioritize the well-being of mankind.

First and foremost, the study of psychology and human behavior—specifically, how illumination
affects people's subjective well-being—is where this topic has scientific significance. The study will
add to the body of knowledge already available on human-centric lighting and its possible advantages
for improving subjective well-being.

By carefully managing the lighting that is already in place, human-centric lighting (HCL) can be
defined to enhance productivity, emotional stability, health, and quality of sleep (K. Houser et al.,
2021). Various lighting configurations affect how light affects human perception both visually and
non-visually (van Bommel, 2006). The idea produces lighting that simulates daylight to support the
body's natural processes and improve performance, well-being, and focus.

As a smart lighting system, HCL provides user-specific implementation for unique demands in addition
to improving well-being and enabling control over light quality and intensity while consuming less
energy (Cupkova et al., 2019). With the advent of energy-efficient LEDs to replace conventional
incandescent and fluorescent lamps, lighting has grown in importance as a feature of modern living
(Kwon et al., 2021). The reason HCL is the most advanced lighting system is because it improves
biological processes by automatically adjusting the lighting's color, illuminance, and temperature to
the user's and their environment's biological rhythms (Figueiro & Leggett, 2021).

Along with biorhythms, different light wavelengths have an impact on blood pressure, pulse, breathing
rate, and brain activity (Dijk & Cajochen, 1997). Therefore, lighting has a direct impact on all facets
of human existence (Mott et al., 2012). The natural circadian rhythm of the day guarantees that the
right amounts of dopamine, serotonin, and cortisol are released, as light and darkness influence the
production of hormones (Blume et al., 2019). In response to Figueiro's (2013) research, light-induced
circadian system abnormalities can result in a few illnesses, such as cancer and trouble sleeping.

For a physicist, light is just one component of the electromagnetic spectrum, which also includes radio
waves and cosmic rays with wavelengths ranging from femtometres to kilometres. The equivalency of
visual effect—that is, the impression of brightness—is the premise that is employed in measuring
human spectrum sensitivity. One wavelength of radiation, ranging from 380 to 780 nm, will be seen as
having both colour and brightness. When two equal-sized visual fields are shown at the same moment,
with the same single wavelength and brightness, an observer will see them as equal in every way,
meaning they have the same visual impact. When two fields with identical wavelengths but differing
radiances are seen, the one with the greater brightness will be seen as.
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The development of smart lighting systems, the growing trend toward energy-efficient lighting
solutions, and growing awareness of the impact of lighting on human health and well-being are driving
the market. The market is expected to be driven by the commercial sector, particularly in the areas of
healthcare, education, and office lighting (Research and Markets Ltd., 2023).

Light

Image forming Non-image

path way

Visual Visual Visual Circadian Acute
performance experience comfort effects effects

v v ‘

forming pathway

[ Psycological functioning ]

Fig.1.1: Pathways of light relevant to psychological functioning

Although this reaction has mostly been shown throughout the night (Rahman et al. 2014), laboratory
investigations indicate that the alerting effects of light may vary by time of day and that gains in
alertness during the day may be negligible in well-rested individuals (Lok et al. 2018).

The cognitive and alerting effects of light are frequently of relevance in the context of companies and
educational institutions looking to enhance performance. Businesses that operate around the clock, in
example, may try to improve workers' levels of nocturnal awareness to lower mistake rates and raise
safety. However, there are not many studies that compare the performance or alerting advantages of
well-planned architectural lighting systems to operational results.
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1.2 TERMINOLOGY

There are several photometric and radiometric terminologies which have been incorporated in this
thesis. Eventually, they need further explanations. This section provides a description of those
terminologies used in this literature.

1. Radiometry: It is also known as optical radiation measurement, is the study of radiant quantities.

2. Photometry: It is a Measurement of radiation that considers human visual perception is one of the
subfields of radiometry

3. Human Vision: The human visual system can be broken down into two parts: the eyes and the brain.
The eyes are image sensors, taking in light and converting it into signals. These signals are sent to the
centres of the brain, which process the signals from the eyes and create an internal “picture” of the
scene. The sensitivity of the eyes depends on whether they are sensitive to bright light or dark light.

The cones are responsible for the sensitivity of the eyes. They have a high resolution and are colour
responsive. Their relative spectral response to light is referred to as the V A function. The cone has a
sensitivity of 555 nm and the rod has a sensitivity of 507 nm.

The rods are responsible for dark adaptive vision. This lack of colour information and poor resolution
1s known as the V' A function.

a. Photopic vision: When the light intensity is greater than 3 cd / m2, the photopic vision occurs, where
the retina’s cone photoreceptors take over the viewing process.
Photopic vision allows the human eye to see the elements of a scene clearly and with high resolution.

b. Scotopic vision: Scotopic vision is when the light level drops below 0.001cd/m2, and the rods are
dominant in the vision process. Scotopic vision allows the human eye to see colourless images with
very low visibility.

c. _Mesopic _vision: When a person has sustained mesopic vision, their cone cells become
progressively less sensitive and rod cells become dominant. This results in a decrease in the resolution
of the scene and a decrease in colour perception. The luminance values of mesopic vision range from
photopic (3 cd/ m2) to scotopic (0,001 cd/ m2).

4. llluminance (E): Incident luminous flux per unit area of a surface is known as illuminance. Unit is
Lumen/m2 or lux.

5. CRI or Colour Rendering Index: Colour Rendering Index (CRI) is a measure of the colour shift
that an object undergoes when the light source illuminates it compared to when a reference source
illuminates the same object at a similar colour temperature. The CRI of natural daylight is 100.

The colour of an object is determined by the spectral power of the lamp that illuminates it.
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6. CCT or Correlated Colour Temperature: It is the absolute temperature of a blackbody whose
colour appearance most nearly resembles that of the light source. Unit is Kelvin (K). The colour
temperature is typically used to describe the colour of a light source by a single distinct value. "The
temperature of a Planckian radiator whose emission has the same chromaticity as that of a particular
stimulus,” is how the CIE [3] defines colour temperature. This means that to a human observer, the
black body's appearance should be the same hue as the test source. However, the CIE did not specify
the level at which chromaticity should be [2]

"identical” thus colour temperature evolved into a broader perspective on the idea. Because of this,
Correlated Colour Temperature (CCT) is employed to introduce a relative assessment of the colour of
light sources in most photometric measurement instances (where light sources have significantly
different spectral power distribution from the Planckian radiator) [4]. CIE 1960 (u,v) diagram is used
to determine CCT of a specific light source by determining the chromaticity co-ordinate of the closest
black-body radiation. CIE 1960 (u,v) diagram defines CCT as "the temperature of the Planckian
radiator whose perceived colour most closely resembles that of a given stimulus at the same brightness
and under specified viewing conditions" [5].
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Warm COLOR TEMPERATURE SCALE Cool

Fig.1.3: Different levels of CCT and their color appearances
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7. Spectral Composition: Radiated power varies from source to source in the electromagnetic
spectrum. The sum of all the radiated power in the electromagnetic spectrum is known as the spectral
composition of visible spectrum. Spectrum power data is typically presented in the following formats:

a. One-dimensional chromatic presentation: The brightness of the line and colour at a particular
wavelength serve as representations which range a wide spectrum of wavelengths. The lines can be
continuous or separated. [1]

b. Two-dimensional presentation or Spectral Power Distribution (SPD) Curve: These plots are
represented by a wavelength's radiant power and colour which frequently used to represent spectral
composition. The graph shows wavelength on the x-axis and spectral power magnitude in the y-axis.
The SPD Curve displays the type of emitted energy from the radiator body shown over a variety of
wavelengths. While gas discharge lamps display a line spectrum with a discontinuous spectrum and
thermal radiators provide a continuous SPD curve. It gives details on the total amount of radiation and
how much of it is visible.
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Fig.1.4: Spectral Power Distribution (SPD) curve of Cool White & Warm White LED
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2.1 LITERATURE REVIEW

Research on the relationship between lighting and human performance at work have been investigated
for a very long time. Numerous field investigations have been conducted in this context since the dawn
of the 20th century. There have been plenty of assertion-like statements made regarding how lighting
affects productivity and human work performance. There are not many notable field studies that need
more research just yet.[6] [7] [8].

Research was done in the initial stages of the inquiry. Beutell (1934) made the first attempt to develop
a generic model of how lighting affects work. His approach was to first describe a normal task, then
analyse the lighting effects and determine the illuminance for each performance level [9].

Beutell's idea was taken up by Weston (1935, 1945) as the basis for a method he developed to
investigate the effects of illumination on productivity. He carried out a basic measurement and
identification exercise. It was a Landolt ring chart. He asked the participants to read the diagram and
mark each ring with a gap pointing in one direction. The amount of time required and the quantity of
errors committed were calculated under various lighting circumstances. Metrics of accuracy and output
velocity were subsequently determined by combining the measurements []. Weston's (1945) findings
were repeatedly confirmed using a variety of visual tasks (Khek and Krivohlavy, 1967; Boyce, 1973;
Smith and Rea, 1978, 1982, 1987; Rea, 1981).[10]

In the research reported here, we examined two extremely energy-efficient lighting scenarios for
evening office lighting—that is, electric lighting that is usually utilized for around two hours in the
evening. For several years, the Solar Energy and Building Physics Laboratory's experimental building
on the campus of the Swiss Federal Institute of Technology in Lausanne has been successfully using
the first of these lighting scenarios, also known as the "Reference"-scenario, with a Lighting Power
Density or LPD of 4.5 W/m2. The second lighting scenario, also known as the "Test" scenario and with
a lighting power density of 3.9 W/m2, uses less energy and produces greater workplane illuminances,
but it also increases the danger of uncomfortable glare. To develop a lighting solution for nighttime
office lighting that offers the best trade-off between energy-efficiency, visual comfort, and visual
performance, the study set out to carefully examine the two lighting scenarios. To achieve this, 20
human volunteers participated in subjective evaluations of their visual comfort as well as objective
visual performance tests (both computer and paper-based). Our primary prediction, which the
building's tenants strongly support, was that study participants wouldn't perform worse under the more
energy-efficient "Test" scenario than under the "Reference" scenario. We have utilized an overview of
the computer-based FrACT exam that we employed for our study for this purpose. (a) illustrates how
the four direction keys are used during the FrACT; (b) explains the "acuity" task; and (c) explains the
"contrast” test. recommended in 1999 by Courret [18]. This test also uses Landolt rings: research
participants are given a white piece of paper with 96 transparent gray Landolt rings written on it. Pupils
are instructed to record the number of rings counted for each of the four potential orientations (open
on top, open on bottom, open left, and open right) in order to quickly and without writing on the paper
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ascertain the proper orientations of the 96 rings. The how the grey hue contrasts with the paper and the
grey colour of the rings is very weak which makes this quite a difficult task.

A variety of comparisons are used in the study to evaluate the link between task performance, contrast
levels, and illumination. The experiment involved a group of graduate students with the same age
range. This study investigates the impact of varying levels of illuminance as well as contrast on task
performance, based on a lighting laboratory experiment including these 71 participants. A survey in
the form of a questionnaire is given to participants at each session to inquire about their subjective
impressions of the four different illumination levels used in the experiment. Because of this, the current
study provides a scenario of how people act in a specially designed laboratory under different
illumination settings. This establishes a methodology and database to enable future studies
documenting lighting conditions inside buildings, as well as aiding the pertinent professionals to assess
the current inquiry for follow-up research.

When human-centric lighting is carried out effectively, it considers both the visible and invisible
impacts of light to promote beneficial human outcomes. In the worst-case scenario, it's a marketing
scheme meant to deceptively promote lighting fixtures or lighting design options. Ambient lighting
unquestionably enhances human health. However, given the incredible excitement and the realistic
potential, how might human-centric lighting be put into practice? The purpose of this essay is to provide
readers with an overview of the effects of light on health and to propose a human-centric approach to
lighting design that may work in combination with the decision-making process that is already an
integral part of a designer's workflow.

Changes in peripheral autonomic activity are associated with cognitive, emotional, and physical
responses. Measures of skin conductance, or electrodermal activity, are commonly employed as an
indirect indicator of emotional arousal, cognitive effort, or attention since they reflect sympathetic tone.
According to Buchel et al. (1998), the brain mechanisms underpinning the development of the skin
conductance response (SCR) are likewise connected with those involved in emotional processing. On
the other hand, little has been discovered about the functional neuroanatomy of SCR representation
and central regulation.

Functional imaging, electrical stimulation, and brain lesion studies have all provided new insights into
the neural underpinnings of SCR. In accordance to research carried out by Oscar-Berman and Gade
(1979), Zoccolotti et al. (1982), and others, patients with discrete brain lesions of the right hemisphere,
bilateral ventromedial prefrontal cortex, bilateral anterior cingulate gyrus, right inferior parietal lobe
(Tranel and Damasio, 1994), and amygdala (Bechara et al., 1995, 1999) have been found to have
impaired SCR Cerebellum, bilateral extrastriate visual cortices, and left medial prefrontal cortex. The
results we obtained imply that different regions related to emotion and attention play diverse roles in
the production and representation of peripheral SCR responses. We suggest that this functional
configuration allows the organism's continual emotional and attentional states to be integrated with
adaptive body responses.

In the following ways, the study's findings add to the body of knowledge on colored illumination in
space station habitats. First, we showed that, in the simulated environment of a space station hygiene
area, the participants’ GSR, mood, and subjective pleasure were affected by the CCT of illumination.
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Second, we discovered that the participants had the most emotion and happiness in the 6300 K
environment when using the hygiene area simulator in the five CCT settings examined.

An investigation of the potential temporal brain processes for object identification under metal halide
(MH) and high-pressure sodium (HPS) light sources was carried out using a laboratory-based
electroencephalography (EEG) research. In the match/mismatch-to-sample task, research participants
were directed to react to a match or mismatch condition. An item beneath a metal halide and a high-
pressure sodium lamp made up the picture stimulus. Object identification under MH was quicker than
under HPS, according to the scalp topographic plots of the event-related activity. There were also
notable variations in scalp activity. This methodology may serve as a metric in the future to evaluate
lighting installation for the purpose of developing visual acceptability.[18]

The indoor setting has an important influence on human comfort, which has been associated with both
productivity at work and health. This study examined overall comfort in an integrated setting using an
electroencephalogram (EEG) and subjective assessment. A discrete wavelet transform was used to
analyze the EEG signals. Indoor environments have a big influence on cerebral cortex activity, and
temperature, auditory, visual, and overall comfort are all strongly associated. In a comfortable
environment, the parietal lobe (P3, P4) total EEG energy was lower than in an uncomfortable one.
Theta frequency-band in frontal pole (Fpl, Fp2) was dramatically elevated when subjects felt at ease.
These measurements can serve as a biological indicator of overall comfort in various settings.[19]

The results of the personnel's subjective, task, and physiological assessments under various
combinations of three colour temperatures (3000 K, 4000 K, and 6000 K) and five lighting levels (75
Ix, 100 Ix, 200 Ix, 300 Ix, and 500 Ix) have been analysed in this study. The subjective assessment
reveals that, in contrast to colour temperature, which only influences the feeling of spaciousness,
illumination has a significantly substantial impact on brightness, colour authenticity, spaciousness,
weariness, and relaxation. Within the parameters of the study, it has been found that increasing the
lighting of the workspace contributes to increased light comfort, however at a decreasing rate. The task
analysis showed that colour temperature substantially impacts reading efficiency and that, on average,
reading efficiency is increased when one chooses a neutral colour temperature. The physiological
evaluation showed that light strongly impacts the response that occurs in the visual centre.[20]

Based on this research, a comprehensive light comfort zone is proposed, which might serve as a useful
guide for constructing interior light environments and raising the level of pleasure related to the light
environment.

This analysis has emphasized the need for more research on the connection between everyday interior
environments for humans and their health. In this regard, a wider range of cutting-edge biosensing
methods utilized in the domains of building engineering, human physiology, neurology, and
psychology are covered in this review. The correlations and interdependencies between (i) indoor
environmental features and (ii) bio signals, indicating how human bodies react physiologically to
environmental pressures, have been systematically analysed. Relevant papers from the past 20 years
were collected by researching the ScienceDirect, Scopus, MDPI, and ResearchGate databases on the
internet.
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The tools and methods for collecting biometric data were identified and listed, and the benefits and
limitations of the most applicable approaches were evaluated. Although research on productivity have
a more rapid economic impact and comfort studies emphasize user satisfaction and building energy
efficiency, both groups ignore the health implications since they are not evident at the same timescales
declared differently, it is necessary to maintain a balance between the development of resilience and a
suitable degree of fundamental human resilience.

Employee productivity is crucial for most businesses. Studies show that having appropriate indoor
lighting is crucial to maintaining employees' happiness and productivity at work. Nevertheless, it is
exceedingly challenging to track and measure productivity, which restricts our capacity to choose
interior environments that optimize building occupant performance. Rather, work engagement is a
quantifiable factor that has a direct relationship to output. To better understand how illumination affects
occupants' work engagement, this report suggests utilizing electroencephalography (EEG) to evaluate
the frontal asymmetry index (FAI). A statistical approach is used for evaluating occupants' job
engagement during cognitive tasks under the following standard lighting conditions: 200 lux, 500 lux,
and 1000 lux. Customized models are necessary since the results show that various people react
uniquely to different amounts of lighting in the workplace.

Thus, this study also suggests a technique that uses Random Forest (RF) and Artificial Neural Network
(ANN) to predict engagement level for various individuals based on lighting level and their heart rate
(HR), skin temperature (ST), and galvanic skin reaction (GSR). The final classification accuracy for
the 3-scale case is 83.3%, while for the 5-scale case it is 62.2%. The results demonstrate that RF
outperforms ANN in most prediction instances of it. This makes it possible to anticipate human brain
activity and task engagement under various lighting conditions using readily identifiable physiological
data.

An overview of neural recording, traditional signal processing methods, and machine learning
classification algorithms used to track brain activity is provided in this work. To get neural activity in
the human brain, many methods such as electrical, magnetic, neuroimaging recordings, and brain
stimulations are currently accessible. Among these, non-invasive techniques like
electroencephalography (EEG) are frequently used since they can offer respectable spatial resolution
and a high degree of temporal resolution (on the scale of milliseconds). It is also easy, quick, and causes
minimal physical injury or stress to the patients. In terms of signal processing, various techniques can
be used for feature extraction after the brain signals have been obtained. Specifically, brain signals are
often processed in the domains of time, frequency, and/or location. After the features have been
retrieved, the signal is classified using its attributes, such as its mean, variance, or band power. Because
machine learning has a strong ability to interpret complicated volumes of data, its role in this regard
has become increasingly important in recent years. The algorithms used fall classified into three
categories: methods to reward, unsupervised learning, and supervision. The most well-liked machine
learning algorithms are thoroughly examined, and the advantages and disadvantages of each strategy
will be addressed. Finally, a study of these techniques applied to autobiographical memory deficits in
schizophrenia—a novel and highly specialized field of electroencephalography research—is
presented.[24]
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This study discusses several methods for processing and analysing EEG signals. Various methods for
recording EEG signals are discussed. Alpha, beta, theta, and gamma wave cleaning and separation are
also covered. Different mental states are represented by different EEG signal components. Techniques
for processing EEG signals, such as feature extraction and classification, are also covered. EEG signal
classification can be accomplished with radial basis function, K closest neighbour, SVM, LSTM, etc.
Thus, it can be said that the EEG signal aids in the identification of several illnesses. One limitation
and potential avenue for future research is that EEG tracks the activity of many neurons at once. Using
EEG to pinpoint the exact location of single-neuron activity in the brain becomes challenging. For
more reliable results, methods that identify specific neuron activity are also required. Deep learning
techniques need a big dataset to increase accuracy, but they automatically pick up the feature from
EEG data.

Throughout the past few decades, metal halide (MH) and high-pressure sodium vapor (HPS) have been
the most employed light sources in road lighting systems. In recent times, there has been a significant
surge in the utilization of LEDs in various road lighting applications. The colour is among the most
significant features that set apart the two light sources. whereas the visible spectrum has peaks at
various wavelengths in the spectral power density of both MH and HPS light sources, the primary hue
generated by MH sources is blue-white, whereas HPS sources primarily produce yellow. Recent
research has demonstrated that the type of lamp has a significant impact on how well road users identify
objects (Biswas et al., 2018; Rea, 2013, 2014; Boyce Peter, 2014; Rea et al., 2010; Morante, n.d.).
Under the spectrum of these two light sources, it is therefore crucial from the driver's perspective to
conduct a comparative behavioural is the study along the performance analysis. The behavioural and
comprehensive performance analysis study of a person operating a vehicle in a simulated road
illumination condition with light sources from MH and HPS has been carried out in this research
project. The electroencephalography (EEG) investigation and the driver's time reaction were combined
to look into potential temporal processes and notable variations in the distribution of brain waves for
object identification at on-axis (foveal). Throughout the past few decades, metal halide (MH) and high-
pressure sodium vapor (HPS) have been the most employed light sources in road lighting systems.

Since the brain controls skin activity much like it does other organs, we used complexity-based analysis
of EEG and GSR signals to decipher the relationship between the brain and skin reactions to aural
stimulus. Based on the variations in the fractal exponent and sample entropy of embedded sounds, three
musical compositions were chosen. For 11 patients in rest and reaction, we computed the fractal
dimension and sample entropy of the EEG and GSR signals. The findings showed that larger variations
in the complexity of embedded noise in the base music result in more notable changes to the fractal
exponent of EEG signals. Similarly, this pattern is more significantly altered in the fractal exponent of
GSR signals.

In this study, we analysed the effects of two different lighting combinations on participants' levels of
focused attention. To do this, the EEG signal, cortisol release, and proofreading performance were used
to establish the association between the lighting environment and concentration level. Since the results
showed that the lighting environment impacted the participants' levels of attention, the experiment was
conducted out in a concentrated lighting environment to aid in the participants' ability to focus. To this
end, 60 college students—thirty-seven of them female and thirty of them male—were divided into two
groups and given two continuous task times (15 and 30 minutes, respectively). The lighting
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environments employed were focused and general illumination environments. The sustained attention
test was used to measure the participants' levels of concentration using the electroencephalogram
(EEG) signal, cortisol release, and task performance. The findings show that the lighting environment
impacts concentration level; throughout the 15-minute test, participants performed better than controls
in the focused lighting setting, and cortisol release was improved. However, there were no noticeable
variations in cortisol secretion or task performance between the concentrated and broad lighting
settings following a 30-minute task. The EEG data showed that over the 15 or 30-minute task time, the
theta-to-beta wave ratio in the concentrated lighting condition was quite stable. This indicates that
when completing the activity under focused lights, those who participated were able to concentrate
more successfully. In conclusion, the results of this research might influence further investigations into
lighting and cognitive aspects of workplace lighting design.

The impact of light on learning means that the illumination in classrooms has an impact on pupils'
academic achievement. The lighting parameter of illumination is acknowledged as being crucial to
interior lighting. Since memory is one of the primary cognitive processes in learning, the goal of this
study is to examine the impact that classroom lighting has on university students' recollections. Forty
participants went through a psychological memory test in three immersive virtual environments (IVES)
with different lighting levels (100, 300, and 500 lumens). Their neurophysiological responses were
monitored during the tasks using an electrodermal activity analysis, heart rate variability, and an
electroencephalogram. The results highlighted the effects of classroom illumination on students&#39;
memory from a psychological and neurophysiological standpoint. With increasing illuminance, their
performance deteriorated and neurophysiological activation reduced; the most beneficial outcomes
were obtained at an illuminance level of 100 Ix. These findings provide insights into the cognitive
effects of lighting on learning in simulated settings and could have a substantial impact on the energy
efficiency of educational buildings.

Analysing human responses to light may yield important insights that improve cognitive performance,
environmental design, circadian health, and overall well-being. The researchers in this study integrated
VR immersion, EEG, and a machine-learning technique to better understand the relationship between
brain activity and two important lighting properties: the illumination intensity and the correlated color
temperature (CCT). The study had 25 participants who were asked to rate their perceived degrees of
arousal and pleasure after experiencing 17 different artificial lighting conditions. The participants were
then allowed to change the lighting to their preferred level. The experiment's findings showed a
relationship between certain EEG band properties in the frontal and parietal brain areas and light level
and CCT. Based on the EEG data from the participants' first 10 s of exposure, our machine-learning
classification approach was able to predict the behavioural choices of desired vs. non-desired lighting.
This finding has significant implications for the future development of brain-computer interfaces for
automatic lighting adjustment.

This article presents an in-depth analysis of the last 20 years [39]; worth of EEG-based research on
indoor cognitive function, focusing on the major findings, testing strategies for EEG devices, and
experimental designs. Most studies (72.58%) are conducted in controlled climatic chambers, with very
little field research. The study’s [39]; primary goal is to determine how indoor thermal, acoustic,
lighting, air quality, and non-light visual factors influence people’s [39] capacity for clear thought.
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Notably, 88.71 percent of research examines the connections between cognitive function and frequency
domain features and discovers no discernible pattern. Furthermore, greater N1-P3 oscillatory activity
is invariably associated with increased indoor cognitive function. This applies to individual differences,
assessment indicators, and study design. Standardization of experiment design is crucial for data
sharing and outcome comparability. Later studies have limited themselves to how different indoor
environmental factors affect cognitive capacities and improve EEG feature extraction. Building
extensive and accessible EEG datasets is essential. Additionally, the integration of state-of-the-art
technology such as augmented reality (AR) and virtual reality (VR) into diverse settings, such as
underground tunnels and cabins. The growing significance of EEG technology in investigations on
indoor cognitive performance opens the door to more comfortable, healthy, and ecologically friendly
indoor environments.

2.2 Research Problem Formulation

It is evident from doing all the literature reviews that lighting plays a significant role in the society's
growth cycle. Indoor lighting is one place where the impacts of lighting on human wellness are most
noticeable. Since the 19th century, a great deal of study and experimentation has been done to date to
determine how different lighting characteristics relate to human-centric criteria. Numerous studies on
Landolt's ring experimentation have been conducted in both laboratory and outdoor settings. However,
prior experiments were all conducted based on reaction times. The next step in filling the research gap
is to measure the physiological and neuro-cognitive parameters of a task-based Landolt's ring
experimentation conducted in an indoor lighting environment under different CCT'S. Here, we use the
following instruments to measure the neurological and biological parameters: EEG and GSR.
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CHAPTER-3

HUMAN-CENTRIC-LIGHTING
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3.1 HUMAN CENTRIC LIGHTING (HCL)

It is now simpler to alter photometric and colorimetric characteristics, such as colour appearance
(CCT), etc., thanks to developments in LED technology. To better understand how the human body
reacts to various illumination settings, several tests have been conducted recently. Human-centric
lighting's primary goal is to assist in providing users with the necessary range of behavioural,
biological, and visual reactions. Four fundamental lighting design needs may be met to achieve this:
temporal patterns, spatial patterns, light spectrum, and light intensity.

While light level indicates the horizontal illuminance across the workspace, spatial patterns show the
luminance distribution of the light sources in a three-dimensional light field. Chromaticity, Color
Rendering Index (CRI), Correlated (CCT), and other parameters are determined by the light spectrum.
The length and time of the light exposure make up the temporal pattern. A lighting design with these
four elements properly balanced produces higher-quality lighting that enhances both visual and non-

visual reactions.

Melanopsin is a kind of photopigment present in the Intrinsically Photosensitive Retinal Ganglion Cells
(ipRGCs) of human eyes. The circadian, neuroendocrine, and neurobehavioral responses to light that
have been seen in humans (Brainard et al. 2001; Nowozin et al. 2017; Pramag et al. 2019b, Thapan et
al. 2001) at least partially reflect the short-wavelength sensitivity of the ipRGCs.

The physical properties of the light stimuli and the ocular/neural physiology that adapts and reacts to
the stimuli are, in general, the two categories of factors that mediate human biological and behavioural
reactions to light. Light stimuli's physical properties include its timing, duration, spectrum, and
intensity.

GIMAN CENTRIC PARAMETERA / LIGHTING PARAMETERS \

1. Reaction Time (RT) l. CCT
2. Visibility Level (VL) 2. CRI .
3. Small Target Visibility (STV) 3. Luminous Flux
4. Brain Functioning — < Ll Dy
5. Efficiency in Visual and Non- 5. Luminance

Visual Task performance 6. Illuminance
6. Mood 7. Brightness
7. Visual Acuity 8. Reflectance
8. Comfortability 9. Efficacy

10. Glare

9. Circadian Rhythm
\ 10. Cost Function J K /

Fig. 3.1: Link between different illumination and human-centric characteristics.
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3.2 IMPACT OF LIGHTING ON HUMAN PERFORMANCE

Some intriguing discoveries have come from the curiosity to learn more about how people behave and
how the body reacts to various light stimuli. One of those conclusions suggests that light produces a
range of visual and non-visual impacts that impact human functioning in general. Three distinct ways
that light can affect human performance have been identified by Peter Boyce [5], the author of "Human
Factors in Lighting." The circadian timing system, the visual system, and mood and motivation are the
pathways, in that order. It provides a structured depiction of how light affects human performance in
general via the previously listed pathways.

It provides a theoretical framework that delineates the three possible ways in which lighting conditions
may impact human task performance. It presents a conceptual framework for the factors influencing
each route's growth and their interactions. It is possible to characterize any input to the visual system
using the five dimensions of visual size, luminance contrast, color difference, retinal image quality,
and retinal illuminance. These elements are critical in determining the degree to which the visual
system can identify and process the inputs.

Visual Size: The visual size for detection is generally provided by the solid angle that the stimulus
subtends at the eye. It is simpler to recognize the stimulus the bigger the solid angle. While shadows
can be used to increase the effective visual size of some 3D objects, lighting conditions have minimal
influence on the visual size of 2D items.

Luminance contrast: The stimulus's luminance contrast expresses an object's brightness in comparison
to its immediate backdrop. It is easier to perceive the stimulus when the brightness contrast is stronger.
Lighting characteristics, such as altering the luminance’s of its component components and causing
debilitating glare in the eyes, can change the luminance contrast of a stimulus.

Colour difference: The wavelengths that a stimulus emits directly affect how that stimulus appears to
be colored. It is possible for a stimulus that has no luminance contrast to be recognized due to its unique
color contrast with the backdrop. An object's color contrast with its backdrop can be altered by
illumination when several light sources with distinct spectra are used.

Retinal picture guality: A crisp image is optimal for all image processing systems since it helps the
visual system perform at its optimum. The stimulus's spatial frequency distribution [34] can be utilized
to gauge its sharpness. For example, a crisp image will have high spatial frequency components, but a
fuzzy image won't.

Retinal illuminance: The retina's illuminance has a major impact on the visual system's capabilities and
determines the extent of adaptation of the visual system.
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Fig. 3.2: Mechanisms by which light affects the circadian rhythm, mood and motivation, and visual
systems to affect human performance as a whole

Depending on the application, HCL has different advantages [62].

1) Visual Benefits: safety, pleasant and clear visibility.

2) Biological Benefits: enhanced concentration, alertness, stability of the sleep-wake cycle, and
cognitive function.

3) Emotional Benefits: relaxation, better mood, and impulse control.

Human-centric lighting aims to improve visual surroundings and people's task performance while
also reducing the physiological and psychological consequences of artificial and natural light
variations. It is thought that all lighting designs for spaces where people live, work, and study should
take the HCL principle into account. Human-centric lighting aims to improve visual surroundings
and people’s task performance while also reducing the physiological and psychological consequences
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of artificial and natural light variations. It is thought that all lighting designs for spaces where people
live, work, and study should take the HCL principle into account.
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Fig.3.3.: Diagrammatic representation of the neural basis for the physiological effects of light.

The Retin hypothalamic tract (RHT), which connects the intrinsically photosensitive retinal ganglion
cells (ipRGCs) to the brain's central clock (SCN, suprachiasmatic nuclei), receives information about
ambient light through ipRGCs. Other direct projections of ipRGCs include the thalamus and other brain
areas. The properties of the light and/or other mediating elements will determine the reaction. IGL is
an intergeniculate leaflet; LGN is the lateral geniculate nucleus.

In humans, the eye acts as a mediator between light and physiological consequences. When light enters
the eye, retinal photoreceptors are stimulated. These receptors then translate photic information into
neural impulses, which are then sent to different parts of the brain via ganglion cells. Numerous
physiological processes, including as circadian entrainment and phase shifting of the circadian system,
neuroendocrinology control, sleep, alertness, mood, learning and memory, and pupillary responses,
can be significantly impacted by light. Since these processes have been researched the most in people
and animal models, we primarily concentrate on phase shifting, melatonin suppression, and alertness
in this study.

But outside of the lab, each physiological action of light does not happen in isolation; the same light
might affect all or some of these diverse activities at the same time. This is something that should be
kept in mind. Consequently, integrated lighting techniques must consider the wider impacts of light on
human performance and health.
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Work Flow Diagram
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Fig.4.1: From performing previous literature surveys to performing experiments through problem
formulation, the overall pathways of this project are given in a flow chart diagram above.
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The total experimental procedures have been carried out stepwise according to the workflow diagram
above. From the very start, a series of previous studies on human performance under biological and
neurocognitive parameters environments have been thoroughly analysed.

This led the researchers to identify the research gap in the field and helped to form the problem
statement for this project. Additionally, various lighting parameters which have direct and indirect
effect on the human body are identified. As a result, the equipment required for this experiment has
been prepared.

The next step is to select human subjects and explain the purpose of this study to them thoroughly.
After that, they are ready for experiments with their permission. On the other hand, the laboratory set
up is prepared for the experiment. Then, experiments are conducted, data is collected and thoroughly
analysed, and further conclusions are drawn based on the results.
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CHAPTER-5

DIFFERENT EQUIPMENTS USED IN THE EXPERIMENT
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S INSTRUMENTS USE IN THIS EXPERIMENT

5.1 EEG(Electroencephalography)

The body produces many electrical signals and one of which is Electro Encephalography (EEG)
signals, a measurement of the electrical activity that occurs in the brain [2]. EEG, a 40-year piece of
Berger's psychophysical research, has been a research topic since the early 1890's and the first human
EEG was recorded by Hans Berger in the mid-1920's [3].

The brain is composed of the cerebrum, cerebellum, and brainstem. To be more precise, the left and
right hemispheres of the cerebrum are responsible for higher processes including vision, touch, hearing,
learning, and thinking [19-22]. The cerebellum, on the other hand, functions to regulate posture and
balance and is located underneath the cerebrum. The brainstem serves as a hub for relaying information
between the spinal cord and the cerebellum and cerebrum. It carries out several automatic processes,
including breathing, digestion, and sleep cycles.

The corpus callosum, a network of fibres that connects the two hemispheres, allows information to
flow between them. Spatial orientation, nonverbal communication, emotions, creativity, intuition, and
creative expression are all associated with the right hemisphere. The more sophisticated left hemisphere
is mostly associated with language, vocal and written expression, symbols, the abstract, logic, and
science.

In addition, the hemispheres are divided into four lobes, i.e., frontal, parietal, temporal, and occipital,
Again, the lobes are divided into areas that perform precise functions. The brain does not function
independently, and there are many complex relationships between lobes and between the right and left
hemispheres.

The frontal lobe is located near the forehead. The frontal lobe is the part of the brain’s cerebral cortex.
The frontal lobe performs an executive function. Executive functions are the cognitive processes that
are required for cognitive control. For high-level cognitive functions frontal lobe is responsible.
Functions such as problem-solving, thinking, language, memory, judgment, and motion control are
performed using frontal lobe [5].

The occipital lobe is situated in the back part of the brain and comprises the visual cortex (required for

visual data).

The parietal lobe is located close by the centre of the brain, at the back of the frontal lobe, in front of

the occipital lobe (Fig. 1.). The parietal lobe is primarily responsible to deal with

motor functions, sensory information of pain, temperature, pressure, touch, movement, and taste [5].
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The temporal lobe is located at the back of your ears and expanded to both sides of the brain (Fig. 1.).
It is situated below the parietal lobe. The temporal lobe processes memories merge them with

sensations of taste, sound (speech production), sight, and touch [5].

- Cognitive functions

- Short term memory
- Includes the motor
and prefrontal cortex

- Hearing
- Includes the
auditory cortex

()
hH > S
- Smell, touch, taste

- Includes the
somatosensory cortex

- Visual processing

- Color identification
- Includes the
primary visual cortex

- Balance

- Posture

- Coordination
- Attention

CEREBELLUM

- Automatic functions
- Body temperature
- Breathing WERNICKE’S AREA

- Heart rate

BRAIN STEM

Fig.5.1: Four Types of Lobe situated on the brain

Any kind of brain signal might, in theory, be utilized for control as well as information on the
physiological, functional, and pathological state of the brain. In reference to the final point, brain-
computer interfaces, or BCls, receive brain impulses and convert them into commands capable of doing
certain tasks to augment, substitute, repair, or improve human functions. With the advent of robust,
reasonably priced computer technology and a better knowledge of how the brain operates, many
advanced BCI research programs and initiatives have been sparked.

Compared to other approaches, EEG is one of the most widely used methods for capturing neural
signals because it is simple, inexpensive, and radiation-free. Its only drawbacks are that it has poor
signal-to-noise ratio and low spatial resolution.
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Fig.5.2: Neurons produce electrical activity which can be detected with an EEG device

Brain waves, sometimes called neural oscillations, are periodic patterns generated by a single or a
group of neurons.

Fig.5.3: A Flow Chart Based on the Feature of Brain Waves

The individual wears an EEG cap on top of their head to record and store brain electrical activity. To
capture this electrical activity in the form of waves, electrodes must be placed regularly in space on the
scalp. The American EEG Society or the International Federation of Societies for
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Electroencephalography and Clinical Neurophysiology have acknowledged the 10-20 EEG placement
system as an internationally accepted technique for this purpose.

Py /> point .'/ Inion

Fig.5.4: Placements of Electrodes by Following the 10-20 System

The EEG signals obtained during measurements are normally divided into frequency bands, Mainly,
based on the frequency band and signal amplitude, five major brain waves can be distinguished.

The delta band is the slowest wave with the highest amplitude (between 20 and 200 nV), lying within
the frequency range of 0.5 to 4 Hz. It is related with deep sleep and can also appear in a waking state.

Theta waves are within the range of 4 to 7.5 Hz, have relatively high amplitude (>20uV) and are
mainly to signifying drowsiness in young children or arousal in adults. These waves are also related to
creative inspiration and deep meditation.

Alpha waves are normally located in the occipital region, but can be present in posterior lobes. These
waves present frequencies in the range of 8 to 13 Hz, have low to moderate amplitudes (between 30
and 50uV) and commonly appears as a round- or sinusoidal-shaped signal. This brain rhythm can be
associated with relaxed awareness without any attention or concentration.

Finally, Beta waves present frequencies within the range of 14 to 26 Hz (sometimes higher frequencies
are mentioned) with small amplitudes (between 5 and 30 nV). These waves are generated principally
over the frontal and central regions of the brain and can be associated with thinking.

Frequencies exceeding 30 Hz (mainly up to 45 Hz) correspond to the gamma band (occasionally
designated as fast beta waves) characterized by their tiny amplitudes(<5uV).
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Fig.5.5: Brain Waves in Typical EEG

The electrode placement standard that is widely accepted for labelling the electrodes on the scalp is the
10-20 system. The electroencephalogram (EEG) signals are captured by these scalp electrodes. The
link between the location of electrodes on the cerebral cortex and the standard is described. This system
has been authorized by the International Federation of Societies of Clinical Neurophysiology. The
standard places electrodes using letters and numbers. A letter and number have been used to identify
each electrode. The letter designates the brain region. The number indicates which hemisphere is
dominant—the left (odd) or right (even). The nose is the place where the forehead and nose meet. The
lowest point, or hump, on the back of the brain is called the interneon. This graphic illustrates where
the electrodes should be placed using this technique.
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Fig. 5.6: International 10-20 System [1].

The EEG raw data contains a variety of physiologic artifacts; thus, we examined the data by identifying
which kind of artifact this is.

The most prevalent artifacts are muscle artifacts which are known as myogenic potentials. The
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potentials produced in the muscles are often shorter in duration than those produced in the brain, and
they may be readily distinguished based on their length, morphology, and firing rate (i.e., frequency).
Certain individuals tense their frontalis and orbicularis muscles. These contractions are primarily
frontal, happen 50-60 milliseconds after each flash, end when the eyes are opened and paralyzers are
used, and do not coincide with any changes in the EEG.

Eye movement: Eye movements may be used to distinguish between different stages of sleep and are
shown on all EEGs. With the cornea, the positive pole oriented anteriorly, and the retina, the negative
pole orientated posteriorly, the eyeball functions as a dipole. Any electrodes close to the eye can detect
the large-amplitude alternative current field produced as the globe spins around its axis. Blinks are
commonly associated with vertical eye movements, also known as the Bell phenomenon. Symmetric
downward deflections are produced as the cornea, or positive pole, moves in greater proximity to the
frontopolar (Fpl-Fp2) electrodes during a blink. The positive pole of the globe, or the cornea, travels
away from the frontopolar electrodes during downward eye movement, resulting in an upward
deflection that is best captured in bipolar longitudinal montage channels 1 and 5. The lateral frontal
electrodes F7 and F8 are primarily affected by lateral eye movements (see photos below). The positive
pole of the globe travels toward F7 and away from F8 during a left lateral eye movement. Maximum
positivity in electrode F7 and maximum negativity in electrode F8 are recorded using a bipolar
longitudinal montage, and channels 9 and 13 or 10 and 14 do not exhibit artifacts. Electrode F7 may
have a so-called rectus lateralis; this structure is best seen in the vertex reference montage. It's the
opposite with right lateral eye movement. Two distinct sorts of artifacts can result from respiration. A
single electrode's impedance is physically impacted by one sort of activity, which is slow and rhythmic
in nature and synchronized with breathing motions.

Artifact of sweat. Extremely low-frequency oscillations (0.5-0.25 Hz) are what characterize this.
Sweating on the left side is suggested by the distribution seen here (occipital electrode O1, mid-
temporal electrode T3). The distribution of slow rolling eye movements is inconsistent with
morphology and frequency, as seen.

5.2 GSR (GALVANIC SKIN RESPONSE)

An important aspect of human life is emotion. Their identification is an effective instrument for many
uses, including industrial and medical ones. [1]. Because of this, researchers have worked for the
last decades to create techniques that can automatically detect an individual's emotional arousal based
on physiological changes. [3].

Indeed, the physiological alterations are thought to be a reliable way to assess the psychological and
emotional states of subjects since emotions control the Autonomic Nervous System (ANS), which
results in variations in heart rate, respiration rate, and sweat secretion. [2].

In the field of emotion study, the Galvanic Skin Response (GSR) is one of the most intriguing
physiological indicators.
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The relationship between GSR activity and mental state was initially discovered by Vigouroux [4], who
also discovered a correlation between skin resistance and patient sedative concentrations [1, 5].

The electrodes used in GSR measurements must be sensitive to changes in sweat gland activity and
capable of transmitting this information to the recording device because the measurements are based
on the detection of changes in electrical (ionic) activity. The sympathetic division of the autonomic
nervous system (ANS) causes perspiration in humans in response to stimuli such as sounds, pictures,
and physical exertion. Electrodermal activity (EDA) and skin conductance (SC) are other names for
Galvanic Skin Response (GSR), a biometric signal which reflects changes in the electrical
characteristics of the skin brought on by Autonomic Nervous System (ANS) activity. Data is measured
in micro-Siemens (US) and collected at sampling speeds ranging from 1 to 10 Hz. Skin electrodes are
an easy-to-apply tool for measuring skin conductance.

The signal's time course is thought to be the outcome of two additive processes: a faster-varying phasic
component (fluctuating within seconds), and a tonic base level driver that fluctuates extremely slowly
(seconds to minutes).

5.2.1Skin and Sweat Glands Anatomy and Physiology

The skin, which is the body's outermost layer, is home to a complex array of organs. The epidermis,
dermis, and hypodermis are its three distinct layers (Figure 1). The cutis is composed of the dermis and
epidermis, whereas the hypodermis makes up the subcutis.

Epidermis: The epidermis, which is found on the skin's surface, is the cutis' uppermost layer. It is
made up of epithelial tissue, which gets increasingly hornier as it approaches the surface [8]. Due to its
dry layer that gets wet during sweat secretion, this area of the skin is crucial to the electrodermal
phenomena.

Dermis: The dermis is made up of two dermal layers and is the thicker part of the cutis. Papillary
dermis is the layer that is closest to the epidermis. Melanocytes, free collagen, and receptor organs are
all present in this layer where blood arteries end in a capillary net. The reticular dermis, the name for
the inner dermal layer, is composed of tough collagenous fibres that provide the skin with a high level
of resistance to rupture [8].

Hypodermis: It is made up of loose connective tissue that acts as a transitional layer between the skin
and the muscle-covering connective tissue. It includes the hair follicles, the nerves and vessels that
supply the skin, and the secretory portion of the sweat glands [8]. The sweat glands release the
perspiration straight onto the skin's surface.

There are over three million sweat glands in the human body, each with a varied density.
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Fig.5.7: Representation of Skin and Sweat Gland

5.2.2 GSR Signal

GSR is a biometric signal with a time component that can be analysed both in the frequency and time
domains [13]. The tonic and phasic levels are the two components that make up the GSR in the time

GSR Signal
Tonic Component Phasic Component
e e : Event-Related Skin Conductance
i Skin Conductance Level (SCL) ! Responses (ER-SCRs)
_______ i Non-Specific Skin Conductance
Responses (NS-SCRs)

Fig.5.8: A flow chart of The Two Components of GSR Based on Time Domain
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The Tonic component of GSR is the low-frequency component, sometimes referred to as Skin
Conductance Level (SCL). The SCL is a slowly fluctuating component that can be influenced by both
internal and external factors, such as skin characteristics or psychological state. It indicates the degree
of nervous system activation in an individual and can be recorded in the absence of any environmental
events or outside stimuli. Depending on their levels of hydration, dry skin, and autonomic regulation,
this component can differ substantially among them. The SCL-only analysis is not frequently utilized
because of interpersonal differences [5][14].

The high-frequency component known as the Phasic component reflects the rapid fluctuations brought
on by the sympathetic arousal response to a stimulus. These variances are known as "GRS peaks™ and
are commonly referred to as Skin Conductance Responses (SCR).

To assess the features of the GSR signal, it is necessary to record it during a baseline—a time when
the subject is not stimulated [6].
From every SCR, the following four important parameters are extracted:

« Latency: the time distance between the stimulus and the peak's occurrence.

The ER-SCRs typically activate 1-5 seconds following the stimulus. The time point at which the GSR
curve surpasses a minimal amplitude requirement (0.01uS) is the peak onset.

* Peak amplitude: this is the difference in amplitude between the peak's onset and maximum.

* Rise time: the interval of time between the peak's beginning and maximum.

* Recovery time: the amount of time between a peak and full recovery
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Fig. 9: A graph of the four important parameters f or Skin Conductance Response

A wealth of information can be obtained from the GSR signal's time domain analysis. Nevertheless,
the GSR analysis is highly challenging, particularly given the significant inter-subject variability of the
signal's components and the high occurrence of confounding variables (such as motion artifacts) that
could alter the four previously defined parameters [13]. The GSR's spectral analysis is simpler to use
and yields less information but more reliable results, especially when the individual is exposed to
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stimuli [13].

Nearly every portion of the body has sweat glands, although some react more strongly to emotional
stimuli than others. The fingers, palmar sites, foot, and wrist are those areas. Compared to other body
parts, the density of eccrine sweat glands is higher in these locations.

Fig.5.10: Measurement Regions for Galvanic Skin Response signal.

These regions are: medial (blue) and distal (red) phalanges of middle and index finger, thenar and
hypothenar eminence areas(green), feet (purple) and wrist (orange) [5].

The GSR can be measured using one of three methods: (1) the endosomatic approach, which applies
no external current; (2) the two exosmotic techniques, which apply either Direct Current (DC) or
(3) Alternating Current (AC) on the skin [17].

Endosomatic measurement: In the absence of any applied voltage or current, an electrical potential
difference can be recorded across the palmar and plantar skin. A reference electrode is positioned in a
comparatively inactive region, like the forearm, and a single electrode is placed on the active spot [17].

Exosmotic measurement with direct current: A tiny, continuous voltage (such as 0.5 V) applied
between two electrodes placed adjacent to each other on the skin's surface allows for the measurement
of a faint current entering the skin. Therefore, the Skin Resistance (SR) or its reciprocal, the Skin
Conductance (SC), can be determined using the principles of Ohm's equation (R=V/I, where R is the
skin resistance, V is the voltage applied, and | is the current measured) [17].

Alternating current exosmotic measurement: This method, which is less popular, can measure the
skin's impedance (SZ) or its reciprocal, which is known as the skin's admittance (SY) [17].
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GSR can be included in an eye tracking study without causing the design of the study to change
significantly. For instance, incorporating GSR into an eye tracking study in TV media research can
assist in determining when in the show people are more emotionally engaged. GSR can also be included
as a workload or stress measure, for instance in a study when it is anticipated that participants' levels
of arousal will fluctuate over time. Lastly, sympathetic activity

processes are reflected by both GSR and pupil dilation, offering information about a participant's level
of arousal or cognitive load during a particular task.

The amount of time it takes for a physiological signal to alter in response to an outside stimulus or
event is known as its response time. Certain physiological signals respond in milliseconds or less; for
example, an EEG reading of a visual brain reaction can be obtained within 50 ms of the start of the
visual event. Because it is confidently possible to link the EEG changes to the stimulus that triggered
them, this is regarded as a high time resolution. We consider a low time resolution when the reaction
time for a GSR signal is on the order of seconds after an event has happened. As a result, it is crucial
to consider the GSR time features when designing the experiment.

Clinical settings have identified a role for GSR examinations. They help therapists diagnose and treat
conditions like hyperhidrosis (excessive sweating), as well as gauge a patient's reaction to specific
stimuli or situations. They are used in therapeutic settings to measure stress and anxiety levels.

5.3 Konica Minolta CL70-F CRI lHluminance Meter

The multipurpose Konica Minolta CL70-F CRI Illuminance Meter measures the brightness, color
temperature, and colour rendering index of various light sources, such as fluorescent and LED lights.
The colour temperature and spectral power density were the main measurements made with this device.
In this case, the device's sensor is a CMOS linear image sensor. Its wavelength is between 380 and 780
nm in the spectrum. A utility software that facilitates communication with PCs is included with the
device. The data that was recorded by the device is extracted by this program.
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IKONICA MINOLTA

Fig.5.11 :Konica Minolta CL70-F CRI Illuminance Meter

Features include:
Simple to use and read display
180-degree rotating receptor head
Cap-free dark calibration Measurement information for dominant wavelength, chromaticity,
excitation purity for flashlights Broad measurement range;
Complies with DIN Class C and JIS A Class; Comes with utility software CL-SUlw
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5.4 The Metravi 1310 Digital Lux Meter

The Metravi 1310 Digital Lux Meter is a tool for determining how bright a light source is. With an
accuracy of £5%, the 4-digit backlit LCD display indicates the measured illuminance value in LUX or
FC (foot-candle) units. A Split Probe Type Sensor, capable of measuring illuminance ranging from 0
to 199,900 lux, is included with the gadget. It is powered by three AAA alkaline batteries.

Fig.12:The Metravi 1310 Digital Lux Meter
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CHAPTER-6

EXPERIMENTATION AND DATA COLLECTION
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6.1 Laboratory Based Experimental Setup

6.1.1 Background of the EXPERIMENT

Landolt C, also known as Landolt Ring, Broken Landolt Ring, or Japanese Vision Test, is an optotype:
a standardized symbol used to test vision. It was developed by Swiss ophthalmologist Edmund
Landolt. The Landolt C is made up of rings with gaps, so it looks like the letter C. The gaps are in
different positions (usually between the left, right, bottom, top, and 45degree positions) depending on
the subject's task. People must decide which side of the gap they are on. The size of the letter C and its
space decrease until the subject makes the specified number of errors. The smallest perceived slit angle
is taken as a measure of visual acuity. It is generally practised in the laboratory

The relevance of light's effects on the non-image-forming system of the human brain is evident, even
though research on this topic is still in its early stages. Only thorough study on this topic will be able
to explain how the brain responds to changes in lighting parameters such as illumination, correlated
colour temperature (CCT), spectral compositions, etc. One of the most essential tools for assessing the
effectiveness of visual impairment is an examination of visual acuity (VA). Still, accurate measurement
and interpretation are difficult. Overall, comparing the various visual acuity assessments across
research is challenging. The two primary categories of tests are resolution acuity, which is the ability
to identify a gap in a ring and includes the Landolt C chart and Tumbling E chart, and recognition
acuity, which is the ability to read letters and includes Snellen charts and Early Treatment of Diabetic
Retinopathy Study (ETDRS) charts [17].

6.1.2 EXPERIMENT’S OBJECTIVE

This type of experimental research is crucial to determine the relationship between indoor
lighting conditions and an individual's ability to focus, feel comfortable, and complete tasks.

Like other field investigations, it is advisable to understand the outcomes of laboratory-based research
on a smaller scale before doing large-scale practical trials. Thus, using this method, the entire
investigation is carried out in a controlled setting. In the Illumination Engineering Laboratory of the
Electrical Engineering Department at Jadavpur University in Kolkata, an experimental design under
indoor lighting scenario has been set up to study how observers behave and perform when recognizing
stuff under various CCTs and lighting configurations.
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6.2_ EXPERIMENTAL DESIGN

6.2.1 PARTICIPANTS

Five participants (three male, two female) were enrolled in this study, with a mean age of 21 years and
a mean deviation of 2.1 years. They were given detailed instructions on the procedure and asked to
sign a consent form before starting the experiment. All participants reported normal or corrected vision
and completed a medical fitness test. Participants were only allowed to participate in the experiment if
they passed the tests. Smoking and drinking were not permitted during the study.

6.2.2 EXPERIMENTAL SETUP

The experiment was carried out on the 5th floor of the Department of Electrical Engineering at the
Jadavpur University in a completely dark room (5m x 5m x 2.5 m). The material absorbed most of
the stray lights from the outside, thus preventing them from disrupting the artificial lighting
environment, the laboratory is completely darkened from natural light. The walls are painted a dark
black colour, while other instruments are covered with dark black cloaks to block light reflection and
protect them from outside stray light. Since typically focuses on the faces, it has a low reflectance of
2.75%.

A single smart LED light which is mounted on inside the dark laboratory room from Halonix, with
electrical ratings of 12 watts, an input voltage of AC 220~240V, 50Hz, Base-B22, and photometric
ratings of luminous flux of 820 Lumen, was included in this testing process. These RGBW LED lights
function from -10°C to +50°C and include dimmable intensity control (0 to 100%), CCT control (2500
K to 6500 K), and color changing features. They can also be operated with a sophisticated 2.4 Hz WiFi-
based Android software.

The Source light is kept at a height of 1m from the working plane. The experiments are performed
while the subjects are positioned on 0.45m chair. Conical-shaped dark black paper is used to cover the
light source to prevent light flux from directly entering the observer's eye. In this case, the black paper
serves as a baffle for the light source. The source is initially maintained at 3000 K CCT and 100%
intensity. In this case, the IS 3646 guidelines are used to identify the nadir point (E4) [63]. Forty-
Eight grid points with a 0.5 m spacing between them are drawn, using the nadir point E4 as the
reference. Six rows and eight columns form each 8x6 grid that is drawn. The distance between the
observer and point E4 is 4.5 m. The frontal region of the subject's eyes is where the grid points are
located (when the experiment will be performed).
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Fig.6.1: Experimental Setup
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The Konica Minolta CL-70F colorimeter assessed the light source’s spectrum compositions at four
distinct CCT levels (3000 K, 4000 K, 5000 K, and 6000 K).

TEST-180904 556 02° 3006K

Fig.6.2: SPD of the light source(3000K)
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Fig.6.4: SPD of the light source (5000K)
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Fig..6.3:SPD of the light source(4000K)
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Fig.6.5:SPD of the light source(6000K)
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6.3 Test of self-paced landolt ring chart

140 Landolt rings were printed on grey paper and put in a 10 x 14 matrix for each chart. With the gaps
pointing in the direction of one of the compass's eight points, each ring featured one or more holes.
Headrests held the subjects' heads at a set distance of 410mm while they completed the tasks. The
participants were instructed to study the matrix and, as soon as accurately as they could, cross off all
the rings that had a gap in one certain direction that seemed to be a C. The subjects controlled the speed

at which they performed; it was self-paced. Both the completion time and the total number of
commission and omission mistakes were noted.
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Fig..6.6: Landolt’s Ring chart
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6.4 GSR circuit
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Fig 6.7: GSR Circuit Diagram

GSR sensor: It measures the galvanic-psychological reflex. This phenomenon is used to gauge the
activity of the sympathetic nervous system by causing a change in skin conductivity during times of
stress, excitement, or shock. Here, the Arduino UNQO's AO pin receives an analog output from the GSR
signal. VCC and the Arduino UNO's 5V are interconnected. Furthermore, a human finger is attached
to the red point to accumulate data.

A real-time clock (RTC) is a type of digital clock in which the primary function is to record the current
time, date, and year exactly, even when the power source is disconnected or the device is in a state of
low power. The DS3231 is an inexpensive, very accurate 12C real-time clock that features a crystal and
a temperature-compensated crystal oscillator (TCXO) embedded into it. Here, the Arduino UNQO's SDA
(serial data) and SCL (serial clock) have been linked to the SDA and SCL of the RTC module,
respectively. In this case, the RTC module functions as a slave, and the Arduino UNO is the master of
the system.

The Serial Peripheral Interface (SPI) protocol is implemented by microSD controller modules to
interface with microcontrollers and other computers. Here, PIN 12 of the Arduino UNO is connected
to MISO (Master IN, Slave OUT). Pin 11 of the Arduino Uno has been connected to MOSI (MASTER
OUT, SLAVE IN). A serial clock, or SCK, is attached to an Arduino UNO pin with the number 13.
The Arduino UNQ's 4-number pin has been attached to the chip select (CS) pin. The microSD card
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value will be 1 if the 4 number pin of the Arduino is high, which indicates that the CS is high.
Furthermore, the microSD card module will be off if the CS is high. On top of that, if CS is low, the
microSD card module will be on. We refer to it as the active high configuration value. Digital pin 5 of

Arduino is connected with the LED .

Fig. 6.8: Laboratory Developed GSR Module

6.5DATA COLLECTION

The subject’s data were collected in two different ways. During each session, the two methods were
used to record each participant's GSR and Electroencephalography (EEG) data.
This was the process followed at the end of each session in the behavioral research.

We ran the experiment on 5 participants (3Male, 2 Female, 18-22 years old). The participants were
given 15 minutes to relax beneath a cool white LED light bulb when they arrived. After explaining the
experiment to participants, asking several questions from them about their health conditions, and
obtaining their consent, we initiated the experiment. Participants did not drink alcoholic/caffeine
beverages within 48 h before the experiment. The EEG apparatus was put up for data recording at that
period. To ensure proper contact with the scalp, the EEG controller was first charged and the felt pads
were soaked in saline solution. All of the sensors in the EEG cap were meticulously positioned at the
appropriate times during this time. The felt pads were inserted into each sensor one at a time after being
fully submerged in the saline solution.

We performed the experiments in a quiet room without external disturbances.

experiment set up by attaching EMOTIV EPOC X PRO EEG (14 recording and 2 reference electrodes)
and GSR device to the subject. The placement of EEG electrodes was based on the 10-20system. The
EEG cap was then securely placed over each person's skull. The wires that emerged from the sensors
were then connected to the EEG controller, which was placed atop the head. The laptop was linked to
the universal USB receiver, and the controller was turned on. Since EMOTIV PRO, the EEG data
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recording equipment used to conduct this experiment, is wireless, a link between the hardware setup
and the EMOTIV Pro software must be established. For this reason, the "EMOTIV Launcher" program
was launched, allowing the controller to be connected via the USB receiver. The "EMOTIV Pro"
application is launched upon the software's connection to the controller. It was ensured that every
electrode was positioned correctly and had a low contact resistance. Any electrode with a high contact
resistance may be identified by the EMOTIV Pro program; thus, additional saline solution is injected
into these electrodes to keep the resistance within acceptable bounds.

Fig. 6.9: To check the contact quality

Also, in the case of GSR recording, two electrodes were connected to the fingers of the right hand of
each participant. Participants washed and dried their fingers before the experiment, and we did not add
any gel on their skin and scalp since it was not required for the used EEG and GSR devices. During
the experiment, participants sat on a chair in a comfortable position. The recording of EEG and GSR
data was performed at 128 Hz and 2Hz, respectively
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Fig. 6.10: Data Collection Through GSR Module

The first step, we collected EEG and GSR signals during rest for two minutes (first 60sec eyes opened
and, the next 60secs will be eyes closed) Then, we presented the Landolt’s ¢ chart to the participants
and collected their EEG and GSR signals.
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Fig. 6.12: Subject were doing task under different CCT’S
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CHAPTER-7

DISSCUSION AND ANALYSIS
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7.1 ANALYSIS

The “EMOTIV PRO X” with saline sensors was used in this work; one of the main reasons for choosing
this device was its portability, which was crucial for assuring the participants' free movement during
their performance. The participants were performing in various lighting conditions, and the EEG device
was recording their EEG data simultaneously.

Two reference electrodes, called Common Mode Sense (CMS) and Driven Right Leg (DRL), and
fourteen electrodes (AF3 F3, FC5, T7, P7, O1, 02, P8, T8, FC6, F4, F8, AF4) are included. DRL
should be positioned over the right mastoid and CMS over the left.

Each sensor has a hollow aperture to hold the felt pads, which need to be soaked in saline solution
before being used with the EEG equipment. The outputs of the sensors must be connected to a wireless
controller once the electrodes have been set up and placed correctly.

Using a universal USB receiver, the raw EEG data collected from each electrode is wirelessly sent to
a computer at a sample rate of 128 SPS. "EMOTIV Pro" software may be used to visualize data in real
time.

The raw EEG recording of one of the subjects in each of the illumination scenarios. Because the
electrodes were so sensitive, some noise signals were also recorded even though the electrodes were
solely intended to record brain impulses.

In order to eliminate the artifacts from the raw EEG signals, the data is first cleaned.

Afterwards, the Fast Fourier Transform (FFT) was used to analyse the pre-processed signals and
retrieve relevant data. Plotting of the Power Spectral Density (PSD) of various brain waves and
topographic scalp maps was done every 24 seconds.

7.2 LIKERT SCALE

Rensis Likert presented a technique for evaluating attitudes in his 1932 work "A Technique for the
Measurement of Attitudes,” which gave rise to the Likert scale, which bears his name.

Researchers utilize a Likert scale, which is a unidimensional scale, to gather respondents’ views and
opinions. This psychometric scale is frequently used by researchers to learn about people's opinions
and viewpoints on a product, brand, or target market.

Psychological data come in many forms, from in-person interviews to behavioral observations.
Nonetheless, the self-report Likert scale is currently one of the most often used measuring techniques
(Baumeister et al., 2007; Clark and Watson, 2019).
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This scale may be broadly classified into two categories:

Event Likert Scale as well: Even Likert scales are used by researchers to gather extreme feedback in
the absence of a neutral choice.

A 4-point Likert scale for importance enables researchers to incorporate four extreme choices in their
analysis without providing a neutral option. Here, a 4-Point Likert Scale is used to illustrate the various
degrees of significance.

8-Point Likert scale: This is a modified 4-point Likert scale, with eight alternatives to gauge the
likelihood of a recommendation. That is the sole modification from the previous explanation.

Odd Likert Scale: Researchers provide participants the option of replying neutrally by using the odd
Likert scale.

5-point Likert scale: This unusual Likert scale question has five answer alternatives. Researchers use
it to collect data on a topic by giving respondents the opportunity to pick a neutral response if they
would like not to answer from the extreme choices in their study design.

7-point Likert scale: At the extremes of a five-point Likert scale question, the seven-point Likert scale
adds two extra response possibilities.

9-point Likert scale: Although they are not very popular, you may use a 9-point Likert scale by giving
the 7-point Likert scale question two extra answer choices.

Using this Scale in a market research survey has several benefits. They are as follows:

Implementation simplicity: This widely recognized scale is simple to comprehend and use with a
variety of employee or customer satisfaction questionnaires.

Options for quantifiable answers: Quantify Likert items that don't seem to relate to the phrase, then use
the findings of your statistical analysis.

Examine the ranking of viewpoints: A sample with varying opinions on a given issue may exist. The
opinions of those questioned are ranked using the Likert scale.

Easy to react to: Respondents can rapidly respond to the question and comprehend the purpose of this
scale.

Here, on the basis of the Landolt's ring chart experiment, the Likert scale approach is employed to
produce the behavioural research on Reaction Time (RT) and the total marks gained by each participant
under various CCTSs.

The experiment was conducted using four distinct CCT levels, i.e., 3000K, 4000K, 5000K, and, 6000K.
The overall number of marks given and the total number of “Landolt Ring C” Openings vary for each
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CCT levels. Here, each “C” carries out 5 marks. There is total 32 numbers of “C” in 3000K, and 160
marks are allotted; 40 numbers of ‘C’ in all in 4000K, and 200 marks have been awarded; 47 numbers
of “C” in total and 235 marks allocated in 5000K and 44 numbers of total “C” in 6000K, and 220 marks
are allocated to them.

For the experimentation, a subject may be given a Landolt's Ring C chart and instructed to mark only
the number of "C." If the subject skips or misses, they must determine how many misses are deducted
from the total number of marks received,; if a false positive occurs, five marks will be deducted. Once
the number of misses, false positives, and total marks, the reaction time which is a measure of how
quickly the body reacts to a stimulus has been determined. Next, we must average both their average
reaction time and the total amount of marks they received out of 100. Finally, we need to generate two
graphs: one shows how response times drop as CCTs rise, and the other shows the relationship between
CCTs and the overall number of points scored out of 100.

CCT(K) | RT_AVG(SEC) MARKS_AVG
3000 66.6 96.75
4000 100.2 97
5000 75.8 98.296
6000 64.4 98.636

Table. 1: RT average data and Average Marks obtained w.r.t. CCT levels

7.3 EEGLAB ANALYSIS

MATLAB R2021 has been used for preprocessing and analysis of the gathered EEG data. After every
session, the recordings were downloaded in European Data Format (.EDF) and stored on a laptop. After
all of the EEG recordings of every subject under every lighting condition were

accessible, the data processing procedure got underway.

It was first necessary to acquire the "EEGLAB™ MATLAB toolbox, which has several extensions for
EEG signal processing along with an interactive graphical user interface.

This made the process more efficient. The interactive MATLAB toolbox EEGLAB is designed to
interpret continuous and event-related EEG, MEG, and other electrophysiological data. It does this by
employing several techniques such as independent component analysis (ICA), time/frequency analysis,
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and artifact rejection. EEGLAB was initially created on MATLAB 6.1 running on Linux. It is
compatible with MATLAB versions 6 (R13) and 7 (R14) running on Windows, Linux, or Unix
(MATLABV6 or current v7 suggested).

Setting up the link between MATLAB and EEGLAB was necessary before starting the data processing.
The procedures used for analysing EEG data.

Preprocessing individual data was the first and most important step. This stage removes most of the
disturbances and artifacts from the recorded signals, making it possible to recover useful information
later on from the preprocessed signals.

Raw EEG Recordings

« Theta (0.5-3 Ha),
Delta (4-7 Hz),
Alpha (8-13 Ha),
Beta (14-30 Hz),
Gamma (3145 Hz)

Power Spectral Density (PSD)

Fig.7.1: EEGLAB Preprocessing
There are the steps followed for preprocessing EEG data in eeglab:
» Start EEGLAB.

To use Matlab, simply type "eeglab™ and press Enter.The primary EEGLAB window, which is blue
and has seven menu titles, should appear.
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4 EEGLAB v2024.0 - a X

File Edit Tools Plot Study Datasets Help ERPLAB Eyetracker ERPsets

No current dataset

Suggested steps to get started
— Create a new or load an existing dataset:
Use "File > Import data" (new)
Or "File > Load existing dataset" (load)
(find tutorial data in sample data folder)
— If newly imported raw dataset
"Edit > Channel locations™ (look up locations)
"File > Import event info" (for continuous data)
— Filter data: "Tools > Filter data"
- Reject data: "Tools > Reject data by eye"
— Run ICA: "Tools > Run ICA" (can take time)
- Reject by ICA: "Tools > Reject data using ICA"
— Epoch data: "Tools > Extract epochs"
— Plot ERP: "Plot > Channel ERP > In scalp array"

Fig. 7.2: opening the EEGLAB

An EEGLAB dataset must include information about the positions of the recording electrodes to create
EEG scalp maps in either 2-D or 3-D format, or to estimate source locations for data components.

Put the channel positions into load.

Choose Edit > Channel locations to load or modify channel location data from a dataset.

[ Edit channel info -- pop_chanedit() = [5] x

Channel information ("field_name"):

Channel label ("label”) AF3 Opt. head center
Polar angle ("theta”) -22.461 Rotate axis
Polar radius (‘radius”) 0.42113 Transform axes
Cartesian X ("X") 76.1528
Cartesian Y ("Y") 31.4828 Xyz -> polar & sph.
Cartesian Z ("Z") 20.8468 Sph. > polar & xyz
Spherical horiz. angle ("sph_theta") 22 461 Polar -> sph. & xyz
Spherical azimuth angle ("sph_phi") 14,197
Spherical radius ("sph_radius”) 85 Set head radius
Channel type EEG Set channel types
Reference Set reference
Index in backup 'urchanlocs' structure 1
Channel in data array (set=yes) [-]
Delete chan Channel number (of 14)
Insert chan ‘ << | < | 1 > >> Append chan
Plot 2-D Plot radius (0.2-1, [J=auto) Nose along +X v Plot 3-D (xyz)
Read locations. | Read locs help \ Look up locs Save (as .ced) \ Save (other types)

_| Qverwrite Original Channels

Help Cancel Ok

Fig.7.3: Channel Location file

A dialog box requesting to utilize conventional channel locations matching to the imported channel
labels (e.g., Fz) from a channel locations file utilizing an extended International 10-20 System will
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display when you call the channel editing window. If not, you'll need to manually load a channel
locations file.

Finding the Channel Locations.

If you closed Edit > Channel locations, open it again. Click "Plot 2-D" above the "Read Locations"
button to see the channels' 2-D positions. If not, you may always select Plot > Channel location > By
name to view a plot of the channel positions at any point during an EEGLAB session. One of the
commands opens a window similar to the one below. Note: To view the channel number for any label
in this graphic, click on it.

4 Figure 3 = (m] X
File Edit View Insert Tools Desktop Window Help

Node @ 08| rE

X
|
=Y

14 of 14 electrode locations shown

Fig.7.4: Representation of 2D channel location

While epocded data may likewise be filtered using this method (each epoch being filtered
independently), we advise screening continuous EEG data before epoching or artifact removal. At
epoch boundaries, filtering the continuous data reduces the introduction of filtering artifacts.

Choose Tools > Filter the data > Basic FIR filter; then, choose "OK" after entering "0.5" (Hz) as the
"Lower edge" frequency.

The signals were passed through a digital bass pass filter with a lower cut-off frequency of 0.5 Hz and
a higher cut-off frequency of 45 Hz, respectively, to remove the high-frequency artifacts.
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4. Filter the data —- pop_eegfilinew()

Lower edge of the frequency pass band (Hz) 0_5\
Higher edge of the frequency pass band (Hz)

FIR Filter order (Mandatory even. Default is automatic*)

*See help text for a description of the default filter order heuristic.

Manual definition is recommended.

I Notch filter the data instead of pass band

[JUse minimum-phase converted causal filter (non-linear!; beta)

Plot frequency response

Channel type(s)
OR channel labels or indices
[JUse frequency domain filtering (faster for high filter orders > ~2000)

Help Cancel | Ok ‘

Fig. 7.5: Filtering the Data

When recording EEG data, the reference electrode that is utilized for all channels is referred to as the
"common" reference for the data.
Re-referencing the data, To execute the pop-Re-ref() function and convert the dataset to average

reference, select Tools > Re-reference. The following dialog appears the first time you call this menu
item for a specific dataset.

&

Current data reference state is: unknown

Compute average reference

[JRe-reference data to channel(s): J
Interpolate removed channel(s)

Retain ref. channel(s) in data (will be flat for single-channel ref.)

Exclude channel indices (EMG, EOG)
Add old ref. channel back to the data

Help Cancel | Ok

Fig..7.6: Re-referencing the EEG Data.
Following that, the affected region is manually removed from the dataset in order to reject all of the
high amplitude artifacts. Care had been taken during the rejection process to ensure that no valuable
brain messages were lost. After manual rejection, around 100 seconds of EEG data were selected and
split into five 20-second epochs.

Choose Plot — Channel data (scroll) to go through the current dataset's channel data.

68




"4 Scroll channel activities -- eegplot() -- EDF file

Figure Display Settings Help

AF3 hon f” 4 %
F3 RY B ]
FC5 | m AV RN

T7 Mq ln

P7 F ”M'l'l | I
o1
02
P8

T8 A
FC6

Stack

Norm

Scale
F8 {24
AF4 [ I
0 1 2 3 4
Chan. Time  Value =
CANCE <<| <l o =l Ap3 32302 12905 34 | ot REJECT

Fig..7.7: Raw EEG channel data

Even when the preprocessing techniques are sufficient to eliminate high frequency and high
amplitude errors, certain irregularities remain in the data. Because of this, Independent Component
Analysis (ICA) was used to distinguish between true signals and signals with frequency close to brain
signals, such as eye blinks and muscle movement errors. Independent and combined analysis (ICA) is
a technique that may be used to separate a combination of such signals into statistically different non-
gaussian sources. Since there were 14 EEG channels, the approach yielded 14 spatially fixed but
maximum temporally independent components (IC) following ICA decomposition. After that, the
signal was examined to eliminate artifacts brought on by muscular contractions, eye blinking, and

heartbeat.
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& pop_prop() - Component 1 properties
1 | 2 file Edit View Inset Tools Desktop Window Help

Ddde @08 RE
Ic1 Continous data
1 ) & 100
( ) = z
J | J |
0 50 100
- Time (ms)

Activity power spectrum

L ' |
30 40 50

Power 10%log,(11V%/Hz)

L \
10 20
Frequency (Hz)

RejEc  wee| ok |

Fig.7.8: Rejecting eye blink Components by map
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CHAPTER -3
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8.1 EXPERIMENTAL RESULTS:

ic1 Ic 12

Fig.8.1: EEG Spectro-Map

Averaged scalp maps of separate components that are grouped. Within the scalp topographic map, the
color represents activity power: blue denotes low activity power and red denotes strong activity power.
These distinct and irreplicable data features will attract the attention of ICA, resulting in a set of
component maps including numerous single-channel or noisy-appearing components, when too many
types (i.e., scalp distributions) of noise are left in the training data. Examples of these noise types
include complex movement artifacts, electrode and so forth. This will translate into a proportional
decrease in the number of components (degrees of freedom) dedicated to the breakdown of brain EEG
alone.
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Log Power Spectral Density 10°log, ,(:V/Hz)

Frequency (Hz)

Fig. 8.2: Graph of Channel spectra and map

From here, it is clearly shown that at 6000 K, while doing the task performance, these alpha waves
occur at frequencies between 8 to13 Hz, where in this graph it is showing that highest peak occurs at
vicinity of 10 Hz. From which we can conclude this rhythm of the brain can be linked to a state of calm
awareness devoid of focus or attention when the subject had been doing the task performance. Although
they can occur in the posterior lobes, alpha waves are typically found in the occipital area. and have
low to moderate amplitudes (between 30 and 50uV). The graph also shows that theta waves have an
amplitude of >20uV, fall between 4 and 7.5 Hz, and are mostly used to indicate alertness in adults or
sleepiness in young infants. These waves are also associated with profound concentration and creative
creativity. The results clearly demonstrate that the subject's Theta value was elevated during the 60-
second eye closure required for meditation. When the individual opens their eyes and is requested to
complete the task for that duration, the alpha value is greater, ranging 10 Hz. Following that, a graph
in the beta range (frequency range 20-25) experiences a drop.
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8.2Results based on Baseline Correction of GSR Data

Baseline Correction of GSR AVG_3000K
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Fig.8.3: Baseline Correction of GSR Average(3000K)
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Fig.8.4: Baseline Correction of GSR Average (4000K)
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Baseline Correction of GSR AVG_5000K
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Fig.8.5: Baseline Correction of GSR Average(5000K)
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Fig.8.6: Baseline Correction of GSR Average(6000K)

75




8.3 Results Based on Average Reaction Time and Mark’s Obtained
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Fig.8.7: Graph Between Reaction time and CCT
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Fig.8.8: Graph Between Marks Obtained and CCT
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9.1 CONCLUSION

Despite the difficulties, many HCL researchers have observed user interactions in ways that would not
be feasible without the use of physiological data. Analysing a few of these research reveals that, rather
than relying just on subjective post-test responses, these approaches are also sometimes used to capture
in-the-moment observations of a task.

The study clearly demonstrates that when CCT levels rise, so do the levels of ocular sensitivity and
adaptation.

Moreover, a decrease in an individual's reaction time (RT) results in a reduction in the timing of the
entire series of processes that include vision, object identification and recognition, decision-making
and task execution (i.e., motor action and muscle movements).

Our goal in this experiment is to vary the CCT as our control lighting parameter, which will enable us
to determine the CCT level at which we are getting the best outcome. Accordingly, the best output, or
Average Reaction Time (ART) along with average marks given out of 100, is what is referred to as the
performance parameter in this instance.

Itis also evident from this that when CCT increases, individuals’ average reaction time’s drop, resulting
in quicker task completion times. Further it can be concluded that, as the CCT value increases, it is
evident that the marks earned by the subjects are rising. This indicates that, as the CCT value increases,
the subjects were performing in a more corrected manner.

GSR fluctuations indicates how much is the excitation level of the participant are. The initial values of
all the GSR data under four level of CCT’s (3000K, 4000K,5000K,6000K) is set to zero to perform a
comparison test. It is seen that with respect to time the GSR Average values around the duration of 100
to 150 sec has fallen sharply in negative region. This difference between furthermost negative point
and the initial value is representing the effect of excitement on the subject’s brain function through the
galvanic skin resistance. The graph under four CCTs have shown that there are less fluctuations under
6000K with compared to other three CCT levels (3000K,4000K,5000K). A less fluctuation further
indicates that the subjects were more concentrated during that period. So, here in that experiment the
graphs of the GSR average data with respect to time further validates that at higher level of CCT a
much concentration level of the subject can be achieved which reduces the reaction time of the subjects
and accuracy of the task performance. As mentioned earlier reaction time of the subjects were seen to
be comparatively less and accuracy of the subjects were very high in case of higher level CCT’S.

After scrutinizing all the logarithmic power spectral graph for four CCT levels considered in this
experimentation it is found that among all the four CCT levels in 6000K CCT level the alpha frequency
prevailed in that graph more than the other graphs. It can be concluded from the findings that at 6000K
CCT level, all the participants were more focussed and attentive towards the given task (finding proper
Landolt’s Ring C in the Landolt’s Ring chart).
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9.2 EUTURE SCOPE

In the future, we will be able to recognize things under various CCTs by utilizing other physiological
indicators, such as GSR combined with eye tracking in a virtual simulated street lighting environment.
Eye tracking, which monitors a patient's non-intrusive eye location and motions, can also be used in
future research to determine how a subject recognizes or creates patterns to mark "C" in a Landolt's
ring experiment.

To check the emotions like anxiety, stress, and other things that can be detected from Landolt's ring
experiment, we can also use the Self-Assessment Manikin (SAM) rating scale. This is a non-verbal
pictorial assessment technique that directly measures the pleasure, arousal, and dominance associated
with a person's affective reaction to a wide variety of stimuli. We can compare the GSR and SAM
rating to see which one is better and easier to analyse and more accurate in detecting emotions.
Together with the EEG data, we may classify the GSR data using a variety of techniques, such as KNN,
ANN, Random-Forest, etc. We can then compare these classifications to see which classification is
most appropriate for carrying out work in an indoor illumination circumstance.
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APPENDIX-1

Konica Minolta CL70-F CRI IHluminance Meter:

Main Specifications of CL-70F

Model CAI llluminance Meter CL-70F
Conforms to requirements for Class A of JIS C1608-1 ; 2006
llluminance meter class “llluminance meters Part1:General measuring instruments;
Conforms to DIN 5032 Part 7 Class C
Sensor CMOS linear image sensor

Spectral wavelength range |380 nm to 780 nm
Qutput wavelength pitch 1 nm
Constant light: 1 to 200,000 Ix; 1,563 to 100,000 K

Measuring range (Chromaticity display requires 5 Ix or more)
Flash light: 20 to 20,500 Ix*s; 2,500 to 100,000 K
Accuracy (Standard Ey: £5%+1digit of displayed value
llluminant A) (*1, 2) xy: +0.003 (at 800 |x)
E,: 30 to 200,000 be: 1% +1digit; 1 to 30 bx: 5%-+1digit (*3)
Repeatability xy: 500 to 200,000 kx: 0.001 (*4)
(Standard lluminant A) xy: 100 to 500 bc 0.002 (*4)
(*1) xy: 30 to 100 bc 0.004 (*4)
xy: 5 to 30 b 0.008 (*4)
Visible-region relative Within 9%

speciral response
characteristics (1)
Cosine correction Within 6%
characteristics (f2)

N E,: +5%
Temperature drift (f;) xy: 20.006
- . Ey: £3%
Humidity drift (f,) xy: +0.006
2 AA-size batteries (Alkaline batteries or manganese dry
Powar

cells); USE bus power

Constant light (Maximum): 15 sec

Response time Constant light (Minimum): 0.5 sec

Flash light: 1 to 1/500 sec (in 1-step intervals) (*5)
Correlated color temperature Ty, Difference from blackbody
Auv, XYZ, xy, u'v', Dominant wavelangth A 3, Excitation purity
Pe, Spectral iradiance, E,, CRI (Ra, Ri), Peak wavelength

A p, exposura value

Color indication modes

Other functions Diata meamory: 999 data; Preset function; Auto power off function
Display languages English, Japanese, Chinese (Simplified)

Interface USE 2.0 Mini B

Operation temperature/ -10 to 40°C , relative humidity of 85% or less (at 35°C ) with
humidity range no condensation

Storage temperature/ -10 to 45°C | relative humidity of 85% or less (at 35°C ) with
humidity range no condensation

73 (Wpx 183 (H) x 27 (D) mm (Not including projecting butions)
D (max): 40 mm
Weight (without battery) 230 g

Size
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Metravi 1310 Digital Lux Meter:

Split Probe type separate sensor

Sampling Rate 0.5S

Auto Range

Lux / Fc Selectable

Max / Min Record

Hi/Lo Overload Indication
Data Hold

Backlit LCD Display

Auto Power Off

Low Battery Indication
Range: 0 - 199,900 Lux / Fc
Accuracy: 5%

AAA Battery Operated
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Emotive EPOC X

14-Channel EEG Headset onistrithe 10-20 System (Whole-brain sensing)

Rotating Headband (Enables comfortable data collection)
Bluetooth 5.0 (Fast and reliable real-time data transmission)
9-Axis Motion Sensor (Accurately detects head movements)

Refillable Research-GradeistriSaline Sensors (Maintain consistent sensor

conductivity withoutistriinterrupting your studies)

Active Common-Mode Noise Rejection System (Capture high-quality,
reproducible EEG data)

86




Halonix Wi-Fi Enabled Smart LED Bulb

The 12 watt Halonix Wi-Fi Enabled Smart LED Bulb is capable of Wi-Fi connectivity. It fits into a
B-22 holder and plugs in. The lightbulb may be controlled using a smartphone app. It may have over
a million distinct colors lighting up. It can also change warm white to chilly white. The CCT has a
range of 2500 K to 6000 K. The smartphone application allows the user to adjust the brightness or

intensity as well.

About this item

¢ Wattage: 12 watts smart led bulb, Base-B22, Input Voltage : AC220~240V, 50Hz

« Wifi Requirement: Requires a secured 2.4 GHz Wi-Fi network connection.

« Shades of light-With this Smart RGB wifi Led bulb, you can light up any room with
millions of shades to choose from the colour palette. Choose the brightest colour
while studying or a soft warm shade when you enjoy a cup of coffee. You can
choose a random colour while you party at your home.

« Virtual assistant-Control this smart LED bulb by voice with a virtual assistant such
as Alexa or Google assistant.

¢ Dim or Brighten-Control the brightness of the LED from one to hundred percent
that too of any colour.

« Timing function-With the inbuilt timing function, you can easily automate the LED
to turn on and off at any given time. It is a perfect smart wifi light for home

« Control the lighting at your fingertips; just download the Halonix Wi-Fi app from
play store or apple store

e Warranty- 12 Months

¢ Country of Origin: India

XINBIAH

Main Souce (S)
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APPENDIX-2

GSR CODE

#include <SP1.h>

#include <SD.h>

#include "RTClib.h"

RTC_DS3231 rtc;

#define PIN_SPI_CS 4

File myFile;

const int GSRPIN = AO0;

int sensorValue = 0;

int gsr_average =0;

int human_resistance = 0;

long sum = 0;

constint LED =5;

intk =0;

void setup() {

Serial.begin(9600);

pinMode(LED, OUTPUT);
Serial.printIn("SD card is starting");
SD.begin(PIN_SPI_CS);

if ('SD.begin(PIN_SPI_CS)) {
Serial.printin(F("SD CARD FAILED, OR NOT PRESENT!));
while (1); // stop the program

}

Serial.printin(F("SD CARD INITIALIZED."));
Serial.printIn("RTC is starting");

if ('rtc.begin())

{
Serial.printin("Couldn't find RTC");
while (1);

}
Serial.printin(F("RTC INITIALIZED."));

/Irtc.adjust(DateTime(2024, 01, 9, 18, 37, 45));
delay(1000);

myFile = SD.open("gsr.txt", FILE_WRITE);

if (myFile) {

Serial.printIn(F("Demarkation is done"));
myFile.printin(" ");
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myFile.close();

ks

}
void loop() {

GSR();
RTC();
SDcard();

ky

void SDcard() {
myFile = SD.open("gsr.txt", FILE_ WRITE);

if (myFile) {
Serial.printIn(F("Writing log to SD Card"));

DateTime now = rtc.now();
myFile.print(now.year(), DEC);
myFile.print(-');
myFile.print(now.month(), DEC);
myFile.print(-');
myFile.print(now.day(), DEC);
myFile.print(");
myFile.print(now.hour(), DEC);
myFile.print(":’);
myFile.print(now.minute(), DEC);
myFile.print(":’);
myFile.print(now.second(), DEC);

myFile.print(" -- ");
myFile.print("gsr_average = ");
myFile.print(gsr_average);
digitalWrite(LED, HIGH);

myFile.printin(", "); // delimiter between data
myFile.close();

}else {
Serial.print(F("SD Card: error on opening file ));

Serial.printIn("gsr.txt");

¥

}
void RTC () {

DateTime now = rtc.now();
Serial.print(now.year(), DEC);
Serial.print(*-");
Serial.print(now.month(), DEC);
Serial.print(*-");
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Serial.print(now.day(), DEC);
Serial.print(");

Serial.print (now.hour(), DEC);
Serial.print(":");
Serial.print(now.minute(), DEC);
Serial.print(":);
Serial.print(now.second(), DEC);
Serial.print(* --");
Serial.print("gsr_average =");
Serial.printIn(gsr_average);

}

void GSR () {

for (inti = 0; i <10; i++) //Average of 10 sensor data represents one final value.
{

sensorValue = analogRead(GSRPIN);
sum = sum + sensorValue;
/Serial.printIn(sum);

delay(5);

}

gsr_average = sum/ 10;

delay(500);

sum =0;

}
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